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CHAPTER 16
Cartography
Artist: Bruce Daniel
Ellicott City, Maryland

Designer, Illustrator, Art Director

Project: Bike Map

Client: City of Albuquerque

Illustrator Tools and Techniques

Layers, Symbols, Transparency Palette, Blend Modes, Effects &
the Appearance Palette, Layer Styles

Bruce Daniel:

Maps with Pizzazz
What’s so exciting about a map design? After all, you can log on to
www.maps.com, enter your location and destination and a map with some lines,
street names and maybe a few icons appear showing you a trail for getting from
point A to point B. Most likely, you pay little attention to the lines, icons and
symbols and just want to use the illustration to get you to your destination.

If you’re Bruce Daniel, then designing a map is far from mundane and the use for
your designs have much more impact than maps displayed on web sites and
found at the local service station. For Bruce Daniel, maps may be used in
sophisticated multimedia presentations displayed before the World Court where
17 international judges are about to decide on territorial boundary disputes
between two countries. Or, you might find a Bruce Daniel map designed
specifically for a resort community where every attention to detail including
culture, architecture, and points of interest are carefully assembled together with
precise typography to emphasize the ambiance of the community.

One doesn’t plan on being a cartographer in undergraduate school. It comes to
you perhaps as a matter of coincidence or an alternative for earning a living
while pursuing that dream developed somewhere in the freshman year. For
Daniel that dream was to pursue performing arts. Upon graduating with a major
in theatre from Oberlin College in Ohio, he traveled to Baltimore where he
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worked in set designs and production for experimental theatre groups. Soon
thereafter he headed to New York to work in off-off Broadway theatre, and off
Broadway theatre. (Off-off Broadway theatres have 99 or fewer seats. Off
Broadway theatres have 100 to 499 seats, and Broadway theatres have more than
499 seats).

Like many performing artists Daniel needed to earn a living while pursuing his
dream. He decided to work part time for a design firm where much of his work
was devoted to design. He had fantasies (early in college) of being an architect
until one of his theatre mentors suggested to him, “you make a mistake in a set
design and the mistake is destroyed when the play ends. You make a mistake in
architecture and the mistake outlives you.” Hence, as a matter of coincidence,
Daniel decided to combine his background for set designs and use his talents in a
field where he could create illustrations related to environmental settings.

Daniel was a pioneer with computer graphics who began illustrating on an early
Macintosh computer with Aldus FreeHand. He preferred FreeHand over earlier
versions of Illustrator because of FreeHand’s support of layers, multiple undos,
and ability to draw in preview mode. For Daniel, using layers is a vital part of
creating his illustrations. A necessity he couldn’t live without. Therefore it wasn’t
until version 5 that he tried to use Illustrator when layers, drawing in preview
mode and multiple undos were introduced on the Macintosh version. He still
favored FreeHand and went back and forth between the programs until the
release of version 9 of Illustrator. Today, his tool of choice is Adobe Illustrator 10.

When Daniel begins a new project, he first asks his clients and himself a few
questions. “how much data needs to be handled and shown, what kind of
manipulation of that data is required, how much tracing is needed, how
available and how clean is the source material? What is the overall look and feel
that the client is asking for or needs?  Is this a high-end product for public
marketing and wayfinding, or is it a map to show the intricacies of a piece of
land?  Through discussions with the client a general approach and process is set.
Inspiration comes from various places, depending on the project—sometimes
from the client, sometimes from direct observation of a place, sometimes from
research or ancillary materials.  Data and vision are worked together.”

Daniel spends a lot of time discussing the project with his client and tries to
visualize a picture of the image to be illustrated with regard to the feeling and
sentiment to be captured. He may visit the area where the map is to be created,
research the demographics and history of the area, and study cultural symbols
relevant to the location. Of the experience, Daniel says, “developing the design
standards for each project is by far the most enjoyable part for me.  Taking a
sample area of a map and playing with attributes, appearances, transparency and
effects can be magical or frustrating depending on your knowledge of the
program.  Since almost all of my work begins and ends in the vector
environment, I know Illustrator pretty well.  As I work towards a certain style, I
delve deeper and deeper into the program’s artistic strengths.”

His frustration is sometimes experienced with the program’s performance. As
complex maps are drawn with many layers and elements, the slow down of the
program is sometimes frustrating. “The most difficult part of the design process
in Illustrator is the slowness of the program to display some of the effects and
appearances.  I wouldn’t want the program to dumb down to make it faster, but I
do want it faster.  Every once in a while I’ll have to open a file in an early version
of a program, and I’m stunned at how fast it works (that is if I can remember
how to work around the lack of features).” But with the advantages of
transparency and newer feature rich tools, Daniel returns back to version 10 and
tolerates the slow down as he completes a project.
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THE PROJECT
The City of Albuquerque contacted Bruce Daniel’s company, American Custom
Maps (now part of International Mapping Associates), about doing a bike map
for the city four years ago. Four years later they finally had the budget necessary
and gave Daniel the green light. At the start of a project, Daniel queries the client
as to the look they desire. Is it high tech? Nostalgic? Do they want to highlight a
specific feature or quality of the region? That direction helps to provide a graphic
focus for the map. From there, Daniel often derives inspiration from the locale
itself. He tries to get a sense of the environmental color to arrive at a color
palette. Since Daniel has been a resident of New Mexico for sixteen years, he was
very familiar with the area and had a strong feel for the color, topography,
climate and culture of the region.

He likes to explore different aspects of design and of a program’s features and
tends to employ certain design elements based on what he is interested in at the
moment. For the Albuquerque Bike map, Daniel used drop shadows, glows,
blurs, varying transparencies and different blend modes to provide a map that
visually separates layers of tightly packed information yet still provides a high
level of aesthetic.    “I want people to be able to find the information they are
most interested in and visually forget the rest. They should be able to hone in
and focus on what they want quickly,” says Daniel. At press time of this book,
the project has taken 220 hours (finishing touches are all that’s left). And the
number of paths contained in the map?  —a mere 3,074.

THE STEPS
Step 1: Acquiring data from important sources. In the days of old Daniel had to
start a map project by tediously tracing every highway, street, road, culvert, well,
you get the picture. Now his job is made a little easier by the use of Geographical
Information System (GIS) files from the client. Most cities have a GIS and
therefore can provide geographically referenced data (to real world coordinates)
from a multi-layered database of everything from property to sewer lines. Daniel
first made a list of all of the information he wanted to include in the map. Then
using an Illustrator plug-in called MaPublisher from Avenza, Daniel was able to
easily import the city’s GIS data, which was in a .dxf format, and place each file
on a separate layer in an 8.5 x 11 inch Illustrator file. The data was imported as
vector paths of 1 pt. black strokes. And while Daniel may consider himself
extremely fortunate to have access to this data, non-cartographers may gasp at
the site of this rat’s nest of paths (Figure 16-3).

Step 2: Coloring and texturizing the terrain background image. With the
converted GIS files now in vector format, Daniel then brought the layers into his
25 x 33 inches, RGB, Illustrator file, which contained nothing but guidelines, and
scaled them to fit the document size. He then moved on to importing the next set
of data needed – the background terrain image. This image was acquired from
the Earth Data Analysis Center in New Mexico, who provided high resolution
Digital Elevation Model (DEM) files (Figure 16-4). The DEM files had to first be
opened in an application called Natural Scene Designer from Natural Graphics.
In this program, Daniel was able to render the shaded relief. He also applied
custom colors, using white for the highest elevations, tan for the medium
elevations, pink for the low elevations and light green for the lowest elevations.
“I felt it was important to graphically show the different elevations, especially for
a bike map. I chose the colors I did because I wanted to give a sense of the valley
rising to the east to the mountains and leveling off to the mesa to the west.” He
then brought the file into Photoshop and added a slight texture and softening
with a couple of filters. This not only added visual interest, but hid the artifacts
and seam lines that were inherent in the DEM file. He then applied an
adjustment layer of Hue/Saturation to richen the overall color (Figure 16-5). The
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final 30 x 43 inch, 150 dpi RGB file (all 84.2 Megabytes worth) was saved as a
TIFF and imported into Illustrator.

Step 3: Marrying vector and raster data. Next Daniel sized the terrain TIFF to fit
the page size. Amazingly the vector data fit the raster background terrain image
almost to a tee. “It was quite amazing that two different projections of data from
two different sources fit so well. All I had to do was rotate the terrain image 3/4
of a degree.”

Step 4: Organizing the layers of data. Even though the GIS data and the terrain
image provided the skeletal components of the map, there was still an enormous
amount of work to do sorting out all the information and then stylizing it to look
map worthy. Daniel starts by assigning a different color to each layer. The color
is just a working color so he can distinguish one element from another. The look
and feel for each element would be developed later. Because the map elements
were on separate layers, Daniel could play with the stacking order. “For
example, for this map municipal boundaries are low priority, so I can move that
layer to the back and make it less prominent. On the other hand if this was a map
for a developer, those boundaries would be more important and could be moved
up in the stack.” Next, Daniel made the small roads image layer (the grid of tiny
city streets) the only visible layer and exported it as a TIFF with a resolution of
300 dpi. He opened it in Photoshop, choose Image>Adjustments>Invert (Figure
16-6). Then he placed it back into Illustrator as a linked TIFF. On that layer he set
the Transparency to 43% and set the blend Mode to Lighten. He rasterized that
particular layer in order to eliminate the complexity of all of the many paths, and
consequently,  the numerous  anchor points, on that layer (Figure 16-7).

Step 5: Highlighting bike paths with neon mulitstrokes. Next, Daniel tackled
the most important element of the map–the bike designations. “I wanted the bike
designations to lift right off the page, so I made gave them a neon effect.”
Starting off with lines of 1.5 pts. in yellow, green and blue, he created this neon
effect by applying multiple strokes in the Appearance palette. Daniel selected the
stroke and chose Add New Stroke from the Appearance palette pop-up menu.
Each path for a bike designation contains three strokes of .75 pts. 2 pts. and 3 pts
with rounded end caps. Each stroke is colored in a different shade. For example,
for bike routes , he used  yellow for the .75 pt stroke, light orange for the 2 pt.
stroke and dark orange for the 3 pt. stroke. He repeated this method using blues
for bike lanes and greens  for  bike trails. The varying stroke weights and shades
of color created the look of a neon tube (Figure 16-08). Once Daniel created these
multi strokes he saved them as a new style in the Styles palette by selecting the
stroke and choosing New Style from the Styles palette pop-up menu. He did this
with all of the custom strokes that he created in the map. This allowed him to
easily apply a particular style to any later paths. Daniel made the bike routes,
bike lanes and bike trails sublayers under the main layer of bike designations.
“It’s nice to use layers with sublayers. It provides better organization for highly
informational works that map makers and technical illustrators have to tackle.
You can group and name components and you can apply effects on a layer basis
rather than an object basis.” With 26 layers and 35 sublayers in the final file, it’s
easy to see why organization is a key element in Daniel’s workflow. In addition
to organization, Daniel will often hide his raster intensive layers and even
remove his layer styles temporarily to improve Illustrator’s performance and
speed up his screen refresh. Since the styles are saved in the Styles palette they
are quick and easy to reapply at the illustration’s completion (Figure 16-09).

Step 6: Applying blurs and blends to arroyos. He  then moved to the county
lines layer which he was just a single path which divided two counties. The path
consisted of a .5 pt. black dashed line set to an opacity of 61%. From there he
worked on the arroyos (drainage lines). On this layer, Daniel wanted to give the
impression of a slight scoop in the terrain. To do this, he took the vector path,
which was a 6 pt. brown stroke and applied a 6 pixel blur effect
(Effect>Blur>Gaussian Blur). In the Transparency palette, he then adjusted the
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transparency to 30% and set the blend mode to Luminosity (Figure 16-10). He felt
the shaded depression alone looked like just a variation on the terrain and didn’t
offer quite enough definition, so he added a 1 pt. dashed turquoise line with an
opacity of 43% through the center. Says Daniel, “It’s amazing some of the things
that can be done to simple line work ” (Figure 16-11).

Step 7: Softening the city limits. For the Albuquerque city limits layer, Daniel
used a soft purple line to indicate the boundaries. Again, making that layer the
only visible one, he exported the original data as a TIFF and brought it into
Photoshop. There he created an Alpha channel mask by selecting all of the
interior areas. He then colored the line purple, applied a Gaussian blur of 25
pixels to blur the inside of the city boundaries. He then placed it back into the
Illustrator file as a linked JPEG . He decided on a JPEG format to try to keep the
file size small. With this particular image, the need for quality was small given
how it interacts with the whole map. In Illustrator, in the Transparency palette,
he set the transparency to 60% and the blend mode to Multiply. He then added
back the original vector data as a .5 pt light purple stroke on a separate layer.

Step 8: Stylizing landmarks, parks and golf courses. Daniel then worked
landmark fill layer which he filled with a light red and set to an opacity of 25%.
Next, he created and applied a layer style to the park areas. The layer style
consisted of a light green fill with an opacity of 7%. He repeated the process with
the golf course layer, also using a layer style which he created consisting of a
green fill with 25% opacity. “I like to apply styles to the layer level rather than
the object level. That way the layer style supersedes the object style and acts as a
shell.”

Step 9: Filling the river with water. Next, he worked the river layer that wasn’t a
path, but a shape. Daniel applied a medium blue stroke of .4 pts. and a light blue
fill indicating water.

Step 10: Working on the railroads. From there, Daniel tackled the railroad layer.
For the paths indicating railroads, he used once again employed multiple strokes
(similar to the bike routes in Step 5) of a 4 pt. dashed brown line, a 1.5 pt. white
line and a 2.5 pt. brown line. The blend Mode was set to Darken. Daniel created a
style from the multiple strokes and saved it in his Styles palette.

Step 11: Stroking roads and filling airports. Next he worked on the major roads
layer, where he applied a white 1.75 pt stroke to the paths. Then, Daniel filled the
basic airport shapes with a black fill at 30% opacity and a .5 pt black stroke, while
filling with the buildings within the airport area with a brown fill and stroked
with a .5 brown stroke.

Step 12: Creating a multistroke for  the interstates. Daniel took the interstates
layer and created another multiple stroke for the path. It consisted of a 1.75 pt.
white stroke and a 2.5 pt. black stroke. He then applied a drop shadow effect to
the multistroke and saved it as a layer style in the Layers palette.

Step 13: Creating symbols. Daniel then added the icons that would appear
throughout the map. These icons included highway numbers, bridges, high
schools, places of interest, recreational facilities, trail parking places, and of
course  bike shops. The bike shop icons were numbered, corresponding with a
chart on the back on the map giving exact addresses of the shops. To create these
icons, Daniel drew the various shapes with the Ellipse, Rectangle and Pen tool
and filled and stroked them using various bright colors. He then selected each
shape and chose New Symbol from the Symbols palette. Saving the icons as
symbols gave Daniel a couple of great advantages. First it keeps your file size
smaller, since each symbol is only counted once in terms of memory, no matter
how many  instances (the number of times it appears) of the symbol appear. Most
importantly any time you revise a symbol (color, stroke weight and so on), all
instances of the symbol dynamically update saving a tremendous amount of
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revision time. Daniel took advantage of this short revision time and redid the
original bridge, parking and bike shop symbols.

Step 14: Adding the text. Next, he added the type for various elements of the
map. He added the type as either point type or type on a path (if the road was
curved). He chose Alexa for the map title and mayor’s statement headline, ITC
Clearface Heavy for the city (gray) and county (black) names,  Copperplate
Gothic for the roads (black) and trails (brown) and Frutiger for the points of
interest (burgundy), parks (green), high schools (burgundy), landmarks (green),
rivers (blue) and bike shops (burgundy). He then added .5 stroke in brown, black
and green if the name needed a leader. After viewing the first comp the client felt
that the type for the roads needed to be divided into two  sizes for better
differentiation between the major roads and the street grid. Daniel did that
making the major roads 8.5 pts and the other roads 7.0 pts. He also added an
Outer Glow effect (Effect>Stylize>Outer Glow) around the type for the major
roads which he made into a new style and saved in the Styles palette.

Step 15: Creating folding guides. Daniel then added the guidelines to indicated
the fold lines for the map. The final 24 x 32 inch map would be folded to a
finished size of 4 x 8 inches.

Step 16: Adding the mayor’s statement and photo. Next, he added the Mayor’s
statement, headline, caption and photo. The photo was a four color image placed
as a linked TIFF. The caption and paragraph text was created with Frutiger, 10
pts., black, while the headline was created in Alexa and enhanced with a soft
drop shadow.

Step 17: Creating the compass rose. Daniel created the burgundy, white, gray
and black compass rose using the Ellipse, Star and Pen tools. The outer circle was
another multiple stroke of a 1 pt. light gray stroke, a 2 pt. medium gray stroke
and a 3 pt. black stroke. The spokes of the compass were also a multiple stroke of
a .5 pt. light gray stroke and a 2 pt. dark gray stroke. He made both of these
multiple strokes into layer styles and saved them in the Styles palette. Daniel
filled the center circle with a dark gray to white radial gradient he created in the
Gradient Editor in the Gradient palette. The direction letters were 13.79 pt.
Copperplate Gothic. Once completed, all elements were grouped.  He then
added the Scale element using Frutiger, 10 pts. for the type and .75 pt and 2 pt.
black strokes for the graphic.

Step 18: Creating the legend. The legend was the next element that Daniel
added. He used three layers to create the legend. First, he placed a textured
background as a linked TIFF. He then applied a drop shadow (which was a
saved layer style). And finally, he added the type (Frutiger, 10 pts., black) and
icons describing the bike designations, places of interest, bike shops and so forth.
He then added the legend title in burgundy using the font Alexa and adding a
slight drop shadow behind the title.

Step 19: Adding titles and a frame. The final two steps for this side of the map
were to first add the map title (Alexa, burgundy,  with a slight drop shadow) and
frame. The frame was created by using  two rectangles one for the outside of the
frame and one for the inside. Daniel then selected both and clicked on Subtract
from shape layer in the Pathfinder palette. He then filled the frame white (shown
against black for display purposes only in Figure 16-25). The frame neatly
encased the contents of the map and hid the edges of the various placed TIFFs
(Figure 16-26).

Step 20: Creating guides and creating text. Daniel started the back of the map by
placing working guidelines (complete with gutters) where the folds would be.
He then created his body text within those guidelines, being extremely careful to
avoid the fold lines. Body text was created in Frutiger, of varying pt. sizes, and
heads were created in Copperplate Gothic, again with varying pt. sizes.
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Step 21: Giving photos pizzazz. The challenge Daniel faced for the back of the
map was to take mediocre photos and somehow make them more compelling.
Daniel took the three larger bike shots into Corel Painter where he color
enhanced them and applied a zoom filter and texture to them, giving them some
movement and life.

Step 22: Adding icons and text. The icons for the safety and rules section were
stock infographics (in vector format) provided from the city of Calgary in
Canada for a credit line. Daniel placed a white, rounded rectangle with a light
purple drop shadow behind each icon to help lift the element off the background.
Type was added by each icon in 11.7 pt. Copperplate Gothic for the heads and 9
pt. Frutiger for the body text (Figure 16-18). Daniel also added the skater and
safety circle  graphics (again from Calgary) and applied the same soft purple
drop shadow (Figure 16-29).

Step 23: Creating an advertisement. Daniel then designed the transit ad from an
initial layout provided by SunTran, which illustrated how to safely load and
unload bikes from the city buses.  He started by creating a square with the
Rectangle tool, filling it with a light purple and adding headline type. He then
added an inner bevel effect to the head type and a soft drop shadow to the
turquoise ampersand. He placed three four  color images as linked TIFFs and
added the type (Frutiger, 9.5 pts).

Step 24: Applying heads. Next, headlines were added in the font Alexa with the
same drop shadows as Daniel used for side one of the map. He then added  lines
to visually divide the densely packed information. The lines were 3.39 pt. light
purple strokes, were roughened  (Effects>Distort & Transform>Roughen) and
shadowed.

Figure 25: Placing the cover photo. Daniel then added the cover image. He
placed the four color image as a linked TIFF and then created an opacity mask in
the Transparency palette. He created the opacity mask by making a rectangle
which he filled with the default white to black linear gradient. This allowed the
photo to gradually fade to transparency and blend nicely with the city seal
graphic.

Step 26: Adding the background  image. The 25 x 33 inch, 150 dpi (53.1
Megabytes) textured background was created by colleague Judy Nielson initially
in Photoshop. Daniel then took the image into Painter where he reworked the
texture using the Effects>Apply surface texture and Effects>Focus>Glass
Distortion commands.  He then placed the background  as a linked TIFF and was
positioned it just above the guidelines layer in the Layers palette in the Illustrator
file.

Step 27: Getting ready for print. The final step entailed added guidelines to
indicate the fold lines and trim marks. Daniel does all of his work to the bitter
end in RGB Color Mode. When asked about why he prefers this method, he says,
“It’s an interesting question that I’m often asked about. I prefer working in RGB,
even though much of my work is printed on a CMYK press. Illustrator 10 seems
to have more flexibility in the RGB space for working with filters and effects.
Straightforward Photoshop conversion of RGB to CMYK gives me unremarkable
conversion, so I’d rather work with the printer or service bureau in a conversion
process that is tweaked specifically to their equipment and materials. I don’t
really like the fact that you have to choose an RGB or CMYK color space in
Illustrator. I wish you could create a CMYK color that would retain its numerical
settings when converting back and forth. But in general I’m happy with the final
look and balance of color when processed by competent printers and service
bureaus.” The final file, consisting of 14.2 Megbytes for two Illustrator files and
209.3 Megabytes of linked TIFFs and JPEGs, will be burned to a CD and given to
the City who will take it to their contract printer. The color proof will most likely
be either a Match Print or Kodak Approval print which Daniel will check
carefully for any prepress snafus. When asked if a file of this complexity, with
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3074 paths and many more anchor points, will print ok, Daniel assures that it
will, but says he can always rasterize it as a fail safe. “There is always the need to
balance time, accuracy and production needs, but it seems printing is always the
bottleneck,“ laments Daniel. Due to the complexity of the map, Daniel has
insisted that he be present at the press check to verify that all of the components
print correctly and that the color is right.

Working with Symbols

Bruce Daniel creates small icons and symbols that are reused many times in a single
drawing. Each icon is an illustrated work replicated throughout the design. Periodically he
may decide to change an attribute for an icon. If the icons were drawn, duplicated and
placed throughout the artwork he would need to delete all duplicated icons and replace
them with a new or revised icon. However in Illustrator 10, Daniel uses the Symbols
palette to manage his icons where he freely can change attributes and dynamically update
changes on all instances.

A Symbol is an art object you store in the Symbols palette. In Daniel’s work, it might be an
icon for handicapped access, a sign for a bike path, or a traffic sign. When he creates an
icon, he adds the artwork to the Symbols palette by selecting the paths and dragging to
the palette (Figure 16-36).

A descriptive name can be added for the Symbol by double clicking on the icon in the
Symbols palette or by selecting the fly-away menu and choose Symbol Options from the
menu commands. The Symbols Options dialog box opens where you type the name for
the new symbol (Figure 16-37). Illustrator 10 also offers eight symbolism tools that allow
you to adjust the color, density, size, location, rotation, transparency and style of symbols.

One great advantage of using Symbols is the manner in which Illustrator handles them.
Rather than interpreting Symbols as individual placed artwork, Illustrator sees Symbols
like an image link. The artwork is only used once and each instance is linked to the
original artwork thereby reducing file sizes and complexity in the design. To add a Symbol
to the artwork, click on the Symbol in the Symbols palette and drag it to the document
window.

When Daniel uses many different instances of a given Symbol and later wishes to change
any attributes such as paths, strokes, colors, etc, a single Symbol on the page is edited.
To edit a Symbol, you first need to select one of the Symbols in the document page then
open the Symbols fly-away menu and select Break Link to Symbol. The artwork ungroups
and all objects become editable. In Figure 16-38 the auto and grass colors are changed
from the original design.

The final step is to redefine the Symbol. Select all objects in the edited Symbol. Keep the
selection active and open the Symbols fly-away palette. Select Redefine Symbol from the
menu options. (Figure 16-39). Even easier, simply Option/Alt drag the revised symbol over
the old one in the Symbols palette and is replaced.

Illustrator dynamically updates all Symbols in the document window to reflect changes in
your edits. When working on 50+ MB Illustrator files with 20 or more iterations of the same
icons, an artist like Daniel finds using Symbols to be a great time saver.


